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Preface

Welcome to the Opsware Operational Management Database (OMDB), the first
configuration management database (CMDB) that offers seamless change automation.
Leveraging the Opsware System consisting of the Opsware Server Automation System
(SAS), Opsware Network Automation System (NAS), and the Opsware Application Storage
Automation System (ASAS), the OMDB automatically populates and maintains all the
infrastructure configuration items (Cls), their detailed attributes, and interdependencies.
After the OMDB is populated with the data, customers can easily execute changes to
configure and remediate the IT infrastructure.

Overview of this Guide

This guide describes how to use Opsware OMDB, starting with an introduction to the
system and how to navigate the user interface. It provides information about Search,
Reports, Dashboard, and Custom Reports.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: OMDB Overview: Provides an overview of Opsware OMDB, the OMDB user
interface, the OMDB Client, and the Search feature.

Chapter 2: OMDB Reports: Provides an overview of the OMDB Reports feature, and how
to run, print, export and schedule reports.

Chapter 3: OMDB Dashboard: Provides an Overview of the OMDB Dashboard and how
to set the Dashboard options.

Chapter 4: Creating Custom Reports: Provides instructions for saving a search as a
report, using BIRT RCP Designer to design custom reports, and adding custom reports to
OMDB.
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Conventions in this Guide

This guide uses the following typographical and formatting conventions.

Bold Identifies field menu names, menu items, button names, and
inline terms that begin with a bullet.

Courier Identifies text that is entered or displayed at the
command-line prompt, such as Unix commands, Opsware
SAS commands, file names, paths, directories, environment
variable names, contents of text files that are viewed or edited
with a text editor, source code in a programming language,
and SQL (database) commands.

ltalics Identifies document titles, DVD titles, web site addresses.
Used to introduce new terms when they are first defined in a
document and for emphasis.

Icons in this Guide

This guide uses the following icons.

This icon represents a note. It identifies especially important
concepts that warrant added emphasis.

This icon represents a requirement. It identifies a task that
must be performed before an action under discussion can be

Iz performed.

This icon represents a tip. It identifies information that can
help simplify or clarify tasks.

W
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This icon represents a warning. It is used to identify significant
i information that must be read before proceeding.

Guides in the Documentation Set and Associated Users

The Opsware® SAS User's Guide: Server Automation is intended for system
administrators responsible for all aspects of managing servers in an operational
environment. It describes how to use Opsware SAS, introducing the system and the
user interface. It provides information about managing servers, remediating servers,
script execution, configuration tracking, deploying and rolling back code, and agent
deployment. It also explains how to use the Opsware Global Shell and open a Remote
Terminal on managed servers.

O,osware® SAS User’s Guide: Application Automation is intended for system
administrators responsible for performing the day-to-day functions of managing
servers. It reviews auditing and compliance, software packaging, visual application
management, application configuration, and software and operating system installation
on managed servers.

The Opsware® SAS Administration Guide is intended for administrators responsible for
monitoring and diagnosing the health of the Opsware SAS core components. It also
documents how to set up Opsware user groups and permissions.

The Opsware® SAS Planning and Installation Guide is intended for advanced system
administrators responsible for planning all facets of an Opsware SAS installation. It
documents all the main features of Opsware SAS, scopes out the planning tasks
necessary to successfully install Opsware SAS, explains how to run the Opsware
Installer, and details how to configure each of the components. It also includes
information on system sizing and checklists for installation.

The O,osware® SAS Policy Setter’s Guide is intended for system administrators
responsible for setting up OS provisioning, configuration tracking, code deployment,
and software management.

The Opsware® SAS Content Utilities Guide is intended for advanced system
administrators responsible for importing content such as software packages into

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Opsware SAS. It documents the following command-line utilities: OCLI 1.0, IDK, and
DET (CBT).

* The Opsware® Automation Platform Developer’'s Guide is intended for software
developers responsible for customizing, extending, and integrating Opsware SAS. It
documents how to create Web Services, Java RMI, Python, and CLI clients that invoke
methods on the Opsware API.

Opsware, Inc. Contact Information

For more information, see the Opsware, Inc. main web site and phone number:
* http://www.opsware.com/index.htm
+ 41 (408) 744-7300

For links to the latest product documentation and software downloads, see the Opsware
Customer Support site:

* https://download.opsware.com/opsw/main.htm
For troubleshooting information, see the Opsware Knowledge Base:
* https://download.opsware.com/kb/kbindex.jspa

To contact Opsware Customer Support, see the following email address and phone
number:

* support@opsware.com

* +1(877) 677-9273

1 O Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to the OMDB Client

This section discusses the following topics:
+ Overview of OMDB

« Launching the OMDB Client

+ OMDB Client

+ Key Terms and Concepts

+ Search

+ Quick Search

+ Advanced Search

* ltem Browser

Overview of OMDB

Opsware Operational Management Database (OMDB) is a configuration management
database designed to create and maintain a record of the infrastructure data in your IT
environment. It has the ability to store information from Opsware SAS, Opsware NAS, and
as well as other third party systems. You can use the OMDB Search, Reports, and
Dashboard features to view and analyze IT infrastructure such as applications, servers,
networks, and storage.

The OMDB feature enables you to perform the following tasks:

« Search and browse for configuration items in your IT environment.

+ Create reports and view report results on infrastructure data in your IT environment.
» Run existing reports and schedule reports.

« Aggregate report results to your dashboard.

Create custom reports.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 23
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Perform historical reporting and compare the results with the current report results.
Perform actions on search and report results.

Configure the data stored in third party systems with the OMDB data using the
Opsware Connector Development Kit.

Define security boundaries around the configuration items. You can thus constraint
OMDB feature access based on user permissions.

The OMDB Client provides the following features

Search: Enables you to search and browse for configuration items in your IT
Environment. See “Search” on page 28 for more information.

Reports: Enables you create reports, view report results, run existing reports, and
schedule reports. See “OMDB Reports” on page 43 for more information.

Dashboard: Enables you to aggregate report results to the dashboard. See “Overview
of Dashboard” on page 59 for more information.

Opsware Administration: Enables you to set the options for Scheduled Reports and
Dashboard. See “Setting Dashboard Options” on page 62 for more information.

Launching the OMDB Client
To launch the OMDB Client, perform the following steps:

EF Launch the SAS Client. See the Opsware® SAS User’s Guide: Server Automation for

information on how to launch the SAS Client.

In the SAS Client, from the Tools menu, select Opsware OMDB Client. See

24 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Figure 1-1. This launches the OMDB Client.

Figure 1-1: Launching the OMDB Client

& Opsware Server Automation System
File Edit “iew W= Actions  Window  Help

Global Shell
Opsware OMDE Client wvare Policies

SEFver pdate Cache Chrl4+FS
Opkions
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|Saved Searches ... v| ﬂ - —
2| Independe

Advanced Search _g'_l LinL

E (Optional) To display Search in the Navigation pane, select Search Pane from the
View menu in the OMDB Client.

OMDB Client

The OMDB Client user interface provides an easy access to a OMDB features and
functionality. The OMDB Client user interface has the following main areas:

* Menus

» Navigation Pane

Content Pane

Status Bar
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Figure 1-2: OMDB Client
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Menus
The OMDB Client includes the following menus:

+ File: This enables you to open a new OMDB Client window, close the current
window, or exit all open OMDB Client windows.

« Edit: This enables you to cut, copy, paste, and delete text.

» View: This refreshes the current view and shows the latest information from the core
that you are currently logged into . You can also access OMDB features in the
Navigation pane, such as Reports (Reports, Dashboard, Scheduled Reports),
Advanced Search (Search, Quick Search), and Opsware Administration (Schedule
Report options, Dashboard options). This also allows you to show or hide the Search
pane.

« Actions: Depending on the feature that you have selected in the Navigation pane,
this menu enables you to perform OMDB functions.

« Window: This enables you to access multiple instances of OMDB Client windows, if
more than one window is open.

26 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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* Help: This menu provides help for the OMDB Client. Help F1 provides context-
sensitive help relevant to the current feature window selected or opened (same as
F1). The contents and index will open the SAS Client help system to the main table of
contents.

Navigation Pane

To access OMDB features, select a feature in the Navigation pane. When you select a
feature, the details of it appears in the Content pane. You can access functions related to
it through the Actions menu.

Content Pane

Depending on the selection in the Navigation pane (Advanced Search, Quick Search,
Reports, Dashboard, Scheduled Report Options, Dashboard Options), the Content pane
lists the corresponding information.

Status Bar

At the bottom of the OMDB Client Application window, the status bar provides the
following information:

« Informational text (left hand side) about the selected object
» A progress bar active when retrieving information from the core
* The user ID

» The time zone set in the user profile

Key Terms and Concepts

The following terms and concepts are used in the OMDB feature:

« Configuration Item (CIl): An object which can be viewed and managed with Opsware
OMDB. For example SAS Server, NAS Device, SAS Patch Policy.

+ Attribute: A single property of a configuration item, the value of which describes the
behavior of the configuration item. Configuration items can have one or more attributes.
For example, some of the attributes for the configuration item SAS Server includes
hostname, life cycle, agent status, and management IP.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 27
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Search

In the OMDB Client, the Search feature allows you search for any information about your
operational environment that is available in Opsware SAS, Opsware NAS, and any third
party systems. In the OMDB database using the Connector Development Kit, you can also
include additional configuration items and attributes from third party systems such as
storage management, change management, and ticketing. This allows you to search for
information about your IT infrastructure other than Opsware SAS and Opsware NAS. See
Opsware Connector Development Kit for information on how to add configuration items
and attributes from third party systems.

The OMDB Search feature enables you to perform the following actions:

+ Perform a search by using keywords.

« Perform an advanced search by creating search queries.

« Browse for configuration items in your IT environment.

+ Search for historical data by selecting the date and time for the search query.
« Save a search query.

+ Perform actions on search results. You must have Opsware SAS 6.5 installed to perform
actions on SAS results and Opsware NAS 6.0 or later installed to perform actions on
NAS results.

» Export search results.
+ Customize search results formatting using the Results Options window.

* View Item Browser for search results.

Performing a Search

In the OMDB Client, you can search for configuration items by entering a keyword in the
search text field. The search is carried out against the default displayable attributes
defined for the configuration item in the OMDB data catalog.

The search operation returns only configuration items on which you have the data access
permissions. See Opsware® OMDB 1.0.2 Installation Guide for information on OMDB
permissions.

To carry out a search, perform the following steps:

28 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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From the Navigation pane, select Search. To display Search in the Navigation pane,
select Search Pane from the View menu.

From the drop-down list, select the type of item that is the target of the search.
Figure 1-3 shows a search for the NAS User named Bob.

Figure 1-3: Simple Search in the OMDB Client

N.&.S I=zer Vl
| Bab =
El Enter the search text in the text field. The OMDB Client search feature does not

support a wildcard search and the search is not case sensitive.
Click to search. The search results appear in the Content pane.

(Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

(Optional) Click Results Options to specify the attribute to be displayed as column
headings for the search results. Perform the following steps to customize the column
headings:
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1. In the Results Options window, from the All Available Attribute list, select the
attributes you want to display as column headings for the search results. Click
Add. The attributes now appear on the right pane. See Figure 1-4.

Figure 1-4: Results Option Window
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Stage Hey
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Configuration ferm: SAS_SERWER J
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Sorting Order: ﬁé_sa-e-d =

[ OK ] [ Cancel I [ Apply ] l Help

2. To reorder the attributes, select the attribute and then click Up or Down. To
remove the attribute, select the attribute and then click Remove.

3. To change the display name of the attribute in the column heading, enter a new
name in the Column Display Name field.

4. To select the sort order of the attribute on the search results, select the order
number from the Sorting Order drop-down list.

5. To sort the search results for a each attribute, select Ascending or Descending
from the Sorting Order drop-down list.

6. To make the sorting order case sensitive, select the Case Sensitive check box.

7. Click OK to display the selected attributes as column headings. Click Apply to
save.
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8. To add additional attributes, select the relationship from the Configuration Item
drop-down list as shown in Figure 1-5. The additional attributes appear in the All
Available Attribute list. Perform the instructions listed in steps 1 to 7 to add or
remove additional attributes.

Figure 1-5: Adding Additional Attributes to the Results Option Window
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(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item types in the Advanced Search location in the navigation pane.

(Optional) In the Save Search window, select Save Search as Report Definition to
create custom reports. See “Editing a Report Definition File” on page 68 for more
information.

(Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html
files.

KK (Optional) After you export the search results, you can email the search results by

attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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EEl (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Quick Search
Quick Search allows you to browse all the configuration items available in OMDB by

selecting the configuration item and then the attribute and value for that item.

Performing a Quick Search

The search operation returns only configuration items on which you have the data access
permissions. See the Opsware® OMDB 1.0.2 Installation Guide for information on OMDB
permissions.

To carry out a quick search, perform the following steps:

H From the Navigation pane, select Advanced Search » Quick Search. Quick
Search is displayed in the Content pane as shown in Figure 1-6.

Figure 1-6: Quick Search in the OMDB Client
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From the Item Type list in the Content pane, select the configuration item you would
like to browse. The list of attribute category for the selected configuration item appear
in the Attribute Category list.

Select the attribute from the Attribute list and then select the value for that attribute
from the Value list. The search results appear in the content pane.

(Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item type in the Advanced Search location in the navigation pane.

(Optional) In the Save Search window, select Save Search as Report Definition to
create custom reports from your search results. See creating custom reports for more
information.

(Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as csv or .html
files.

(Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

(Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Advanced Search

In the OMDB Client, an Advanced Search enables you to create queries on search items.
In the search query, you can specify rules and combine each rule with a logical “And” or
“Or” operator. You can use both the “And” and “Or” operator in a single search query.
Each rule is a combination of an attribute/operator/value that enables you to search for a
specific attribute value for the selected search item. For the search item, depending on
the attribute that you select, the options for the operator and value are displayed. You can

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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specify the attribute values by entering text or a numerical value in the text field, or by
selecting a value from the drop-down list, or by selecting multiple values from a list of
values in the Select Values window. See Figure 1-7.

Figure 1-7: Advanced Search

ﬁ Advanced Search
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[ Search ] [ Rezult Options... ] [ Save Search... ] Cancel

The Select Values window appears when you need to specify multiple values for a rule
containing a “is one of” or “is not one of” operator. In this window, you can select multiple
values from the list or add values to the Additional field. See Figure 1-8.

In OMDB when you perform a search of any configuration item and the in the operator
field you select " Equals” or “Does not equal" or “Is one of” or “Is not one of”, then the
values listed in the Value field depends on the values existing in the OMDB atabase as of
the selected date. If the other values in the OMDB database are not relevant for the
selected date then those values will not be listed in the Value field.
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Figure 1-8: Select Va
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You can create complex queries by selecting multiple relationships or in-line blocks for a

configuration item and also multiple rules for each relationship. See Figure 1-10.

Figure 1-9: Complex Query Containing Multiple Relationships
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In a complex query, you can also set the precedence on the Or/And logic for the different
rules in that query. In any query, by default the Or logic takes precedence over the And
logic. In Advanced search, you can use the In-Line Search Block to prioritize the And/Or
logic for rules in a query. See Figure 1-10.

Figure 1-10: Complex Query Containing In-Line Block
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Using Advanced Search you can search for historical data by selecting the date and time
for the search query. You can then compare the historical data with the current results or
create custom reports for both the current search results and the historical search results.
See “Editing a Report Definition File” on page 68 for information on how to create custom
reports.

Performing an Advanced Search

The search operation returns only configuration items on which you have the data access
AS
permissions. See the Opsware® OMDB 1.0.2 Installation Guide for information on OMDB
permissions.

To carry out an advanced search, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search. The
Advanced Search page appears in the Content pane.
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H From the Search for Configuration Item drop-down list, select the item you want to
search. From the As of Date drop-down list select the date and from the Time drop-
down list select the time to carry out the search.

Figure 1-11: Advanced Search in the OMDB Client
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[ Search ] [ Result Options.. ] [ Save Search...

Create a rule by selecting the attribute from the first drop-down list. Depending on
the attribute that you select, options available for the operator and values for the rule
could change.

Bl Select the operator from the second drop-down list. The operator selected defines
how the search text is treated.

H Enter a value in the field or select a value from the drop-down list or click [ to
select multiple values from the Select Values window.

A Click to add additional rules and repeat steps 3 to 5. Click E] to delete any
rules.

Select the logic (And/Or) to be applied for every rule in the query.

B (Optional) To add relationships to the search query, select the relationship ( indicated
in italics) from the first drop-down list. Create rules by following instructions listed in
steps 3to 7.

El (Optional) To set precedence for any rules in a query, select In-Line Search Block
from the first drop-down list. Then create rules for the query by following instructions
listed in steps 31to 7.

KK Click Search to run the search query. The search results appear in the Content pane.

EEl (Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.
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EHE (Optional) Click Results Options to specify the attribute to be displayed as column
headings for the search results. Perform the following steps to customize the column
headings:

1.

In the Results Options window, from the All Available Attributes list, select the
attributes you want to display as column headings for the search results. Click
Add. The attributes now appear on the right pane.

To reorder an attribute, select the attribute and then click Up or Down. To remove
an attribute, select the attribute and then click Remove.

To change the display name of the attribute in the column heading, enter a new
name in the Column Display Name field.

To select the display order of the attribute on the search results, select the order
number from the Sorting Order drop-down list.

To order the search results for a each attribute, select Ascending or Descending
from the Sorting Order drop-down list.

To make the sorting order case sensitive, select the Case Sensitive check box.

Click Apply to display the selected attributes as column headings. Click OK to
close the window.

To add additional attributes, select the relationship from the Configuration Item
drop-down list as shown in Figure 1-5. The additional attributes appear in the All
Available Attribute list. Perform instructions listed in steps 1 to 7 to add or remove
attributes.

EEl (Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the

configuration type in the Advanced Search location in the navigation pane.

EEd (Optional) In the Save Search window, select Save Search as Report Definition to

create custom reports. See creating custom reports for more information.

EHE (Optional) Click Export at the bottom of the screen to export search results. The

Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html

files.
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Ed (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

(Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Exporting Search Results

To export search results, perform the following steps:

E Perform a search in the OMDB Client. The search results appear in the Content pane.

H Click Export at the bottom of the screen to export search results. The Export Results
window appears.

Enter the location, the file name and the file type and then click Export Results. You
can export OMDB search results as .csv or .html files.

Running a Saved Search Query

To run a saved search query, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search.

H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.

Deleting a Saved Search

To delete a saved search query, perform the following steps:

E Fom the Navigation pane, select Advanced Search » Advanced Search.

H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.
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Click Save. The Saved Search window appears as shown in Figure 1-12.

Figure 1-12: Delete Search
Save or Delete your search b—<|

Search Name
| Search for MAS Device |

Saved Searches

|:| Save as a Report Definition

[ Save ] [ Delete ] [ Cancel

Bl Select the saved search and click Delete. Click Delete on the Confirmation window
to delete a saved search.

Item Browser

The Item Browser in the OMDB Client allows you to view all the available attributes for the
selected configuration item. The Item Browser enables you to view additional information
about the configuration item and its relationships.
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The Iltem Browser consists of two main components: the Views pane and the Content
pane. The Views pane lists all the available attribute categories for the selected
configuration item, and the Content pane displays the details of the selected attribute.
When you select an attribute in the Views pane, its corresponding details appears in the
Content pane. See Figure 1-13.

Figure 1-13: Item Browser
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The list of attribute categories in the Item Browser varies depending on the configuration
item returned in the search or report results. For example, Figure 1-13 is an ltem Browser
for the configuration item SAS server, and Figure 1-14 is an Item Browser for the
configuration item NAS device switch.

Figure 1-14: Item Browser for NAS Switch
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Accessing the Iltem Browser
Perform the following steps to access the Item Browser:
E nthe OMDB Client, perform a search or run a report.

H Select an item from the search or report results and then from the Actions menu,
select View. The ltem Browser for the selected configuration item appears.
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This section discusses the following topics:
+ Overview of OMDB Reports

+ Reports Features

+ Opsware OMDB Client Reports
+ User Permissions

+ Launching the Reports Feature
+ Reports Display

* Running a Report

+ Report Results

» Exporting a Report

+ Printing a Report

« Saving a Search as a Report

« Scheduling a Report

Overview of OMDB Reports

The Opsware OMDB Client Reports feature provides comprehensive information about
managed servers, network devices, software, patches, customers, facilities, operating
systems, compliance policies, and users and security in your environment. These
parameterized reports are presented in graphical and tabular format, and are actionable—
which means that you can perform appropriate actions on objects, such as a policy or an
audit, within the report. These reports are also exportable to your local file system (as
.html, .pdf and xls files) to facilitate use within your organization.
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This section contains information about the types of OMDB Client reports, how to modify
report parameters, how to run the reports, and how to perform actions in the report
results.

Reports Features

OMDB Client Reports enable you to perform enterprise health assessments by providing

the following features:

Actionable reports that enable you to take the appropriate action on objects within the
reports. For example, in the list view of a compliance report, you can select a server
and open a Remote Terminal or Server Explorer to browse it, perform an audit, create a
snapshot, create a package, and so on.

The OMDB Client Dashboard provides a display of selected reports. See “OMDB
Dashboard” on page 59.

Reports that are data-secured—controlled by the user’s permissions to the data.
Reports that can be run on either current or historical data.

Reports that are printable and also exportable to .html, .pdf, and .xls formats. You can
export reports to your local file system for use within your organization.

Custom reports can be created and imported. See “Editing a Report Definition File” on
page 68.

Reports that can be scheduled to run automatically and to email the results to you and
others.
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Opsware OMDB Client Reports
Table 2-1 lists the OMDB Client Reports by report folders.

Table 2-1: OMDB Client Reports

Compliance History Historical Compliance Summary - Groups the compliance his-
tory of measured servers

Historical Compliance Detail - Provides device compliance
detail for a specified customer, facility, or group

Device Compliance History - Provides a detailed compliance
state history for all servers, or for one or more selected servers

Device Group Compliance History - Summarizes the compli-
ance history of devices in a specified device group

Customer Compliance History - Summarizes the compliance
history of devices assigned to a specified customer

Facility Compliance History - Summarizes the compliance his-
tory of devices in a specified facility

Deployment Life Cycle | Devices By Type - Filters network devices by group, and non-
network devices by customer, facility, or group

Network Devices By Device Type - Provides a deployment
trend history for the network devices in a specified group,
organized by device type

Servers By Operating System - Provides a deployment trend
history for the servers in a specified customer, facility or group,
organized by operating system and version

Servers By Architecture - Groups the servers in a specified
customer, facility or group organized by architecture
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User Permissions

Reports are controlled by the user’'s permissions to access the data. If a user does not
have permissions to view a set of servers, those servers will not display in a report run by
that user.

Launching the Reports Feature

To launch the Reports feature, perform one of the following steps:
« From the Navigation pane, select Reports.

* From the View menu, select Reports » Dashboard.

* From the View menu, select Reports > Reports.

« From the Navigation pane, select Scheduled Reports.
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Reports Display

The Reports feature display consists of a Search pane, a Dashboard, Scheduled Reports,
report folders, and report parameters.

Figure 2-1: The Reports Feature Display
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Search Pane

In the Reports feature, you can use the OMDB Client Search feature to find reports by
defining specific filter criteria. You can save a search as a report definition and create
custom reports.

Dashboard

The Dashboard provides a display of selected reports. See “Overview of Dashboard” on
page 59 for more information.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 47



Opsware® OMDB 1.0.2 Users’ Guide

48

Report Folders

Reports are organized in the following folders according to regulatory or IT best practice

standards:

Compliance History: This folder contains reports about compliance for software
policies, audit policies, and patch policies by servers, customer, and facility.

Deployment Life Cycle: This folder contains reports about attributes of servers and

network devices.

Custom Reports: This folder contains any custom reports you have created. For more
information on creating custom reports, see ““OMDB Custom Reports” on page 67.

Figure 2-2 illustrates the Report folders in the Navigation pane, including the reports

you will find in each folder.

Figure 2-2: Report Folders
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Report Parameters

Many reports require input parameters in order to be run. For reports that require
parameters, you can run the report with its default parameter values or modify the
parameter values. If you want to run a report that includes or excludes certain servers,
customers, or hardware models, you need to specify this criteria in the report parameters.
See “Running a Report” on page 49.

Running a Report

To run a report, perform the following steps:

E From the Navigation pane, select Reports.

Expand the Reports folder and then expand Compliance History.
Select one of the reports listed in the folder.

If there are no report parameters in the Content pane, click Run.

If there are report parameters in the Content pane, you can either use the default
parameters or change them:

» To use the default report parameters, click Run to run the report.

» To change the report parameters, see “Modifying Report Parameters” on page 49.
Modifying Report Parameters
You can modify the default parameters of a report. If you modify the parameters of a
report, your changes become your default settings for that report. To modify the default

parameters and run a report that includes certain servers, customers, hardware models,
and so on, perform the following steps:

E (Optional) Select the date and interval.

H n the drop-down list for (the Server, Customer, Model, and so on), select one of
Contains, Equals, Begins With, or Ends With.

HE (Optional) Click the ellipsis (...) button to the right of the [Any Value] fields to open the
Select Values window.

Bl nthe Select Values window, select a value in the Available or Selected pane and
then use the directional buttons to include it in or exclude it from your search criteria.

B Click OK to save your changes.
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@ Click Run to run the report.

If data cannot be found to run the report, a “No records to display!” error displays.

Report Results

Report results initially appear in a graphical or list view. The graphical report is an
overview of available data for this report displayed in a pie chart or in a bar graph.

Graphical Report

A graphical report is a bar graph or a pie chart. See Figure 2-3 for an example.

Figure 2-3: Bar Graph
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List Report

A list report is a tabular display of information. Double-click on a row in the list, such as a
server, audit, or policy, for more detail or to perform an action. See Figure 2-4 for an
example.

Figure 2-4: List Report
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Exporting a Report

You can export a report for use in other applications in your environment and attach a
report for email distribution. Depending on the report format, you can export a report to
your local file system as an .html file, a .pdf file, or an xls file.

To export a report, perform the following steps:
E From the report, click Export to open the Save window.

H nthe Save in field, enter a location that identifies where you want to save the file to,
or select from the drop-down list.
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B Select the file type.
Bl Enter a file name.

B Click Save.

Printing a Report
To print a report, perform the following steps:

E From the report, click Print to open the Print window.

H Use the default print options or modify them, and then click OK.

Saving a Search as a Report

Using the OMDB search engine you can generate rich SQL queries and save them as
BIRT reports. In this example, you will use the OMDB search engine to look at the SAS
Server configuration items in the enterprise and save the search parameters as a report.

To customize the report definition file you create in this task, see “Editing a Report
Definition File” in Chapter 4, “OMDB Custom Reports”.

To perform a search and save that search as a report, perform the following steps:

EH Inthe OMDB Client, in the Search pane, expand Advanced Search, and then select
New Search.

H Select the SAS Server configuration item from the Search for Configuration Item
drop-down list.

E To find all servers with a reported OS value of either Linux or Windows, perform the
following steps:

1. Select the Reported OS criteria and Contains from the drop-down lists.
Enter Linux in the next field, and then click the plus (+) button.
Select or from the drop-down list.

Select Reported OS criteria from the drop-down list.

Select Contains criteria from the drop-down list.

o o~ D

Enter wind in the next field.
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Bl Click Search to generate the screen illustrated in Figure 2-1.

Figure 2-1: Search Screen
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BB testwarates VMAARE-S6 4D 28 192168466185 Windows Server 2. YMVWARE, INC MWARE VIRTUAL . testw2k3186

BB vivtaketonon opsw 170227437152 Wiindows Server 2. DELL COMPUTER C.. POWEREDGE 650 vivfaket0000 opsw

BB vivtaketono opsw 171227437152 Wiindows Server 2. DELL COMPUTER C.. POWEREDGE 50 vivfaket00n1 opsw

BB vivtaketonnz opsw 172227437152 Wiindows Server 2. DELL COMPUTER C.. POWEREDGE 650 vivfaket00n2 opsw

BB wakasp2test VMAARE-S6 4D 85 192168466185 Windows Server 2. YMVWARE, INC MWARE VIRTUAL . wkdsp2test

BB winrttest! 7L 192.188.6211 Windows NT 40 DELL COMPUTER C... ORTIFLEX Gi(1 450 winnttestt

BB wipnospvmadB  VMWARES64DC. 152188166185  Windows XP WMWARE, INC VMNARE VRTUBL. . wxprospmalfs |
Opsware Administration Export

These results are sorted by the first column, Server Name.

B Click Result Options to specify a different sort priority.
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The Result Options window shown in Figure 2-2 allows you to select Attributes to
sort, and to set the order in which each is considered.

Figure 2-2: Sort Order

Result Options...

Configuration tem E Attribute Display Marme Sorting
Al Available Attributes Server Matne 1 Ascending
Gengral ~ Serial Nurrber
ALstet Talg Prirnary [P
ifenyole
Litecycle Key — ReTEnG Y
Management P . anufacturer
Mates i el
Opsweare Server D Hostrame
Origgiry
Crigin Key.
Reported 05 Up
Stage
Stage Key
Use
Usze Key
Agent
Agent Checkin
Agert Discovery Date
Sent Status
Agent Status Key &
Column Detail
Configuration et l—/
Airiute: | ‘
Colurnn Display Matne: | ‘
Sorting Ordler | it Sorter _| | | [ Jcass
O I I Cancel ] [ Apply ] [ Help

Name choices.

Click OK.

54

On the Navigation pane, select Operating Systems from the list of Attribute Display

Select order number 1 from the Sorting Order drop-down list.
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The sorted results of this modified search appear in Figure 2-3 below. Red Hat
precedes SuSE, which is followed by VMware, which is followed by the Windows
family of operating systems.

Figure 2-3: Results Sorted by Operating System

Opsware OMDB Client ] 3]
Fle Edt Wew Actions Window Help
Quick Search ' Search
Fas server = Search for Configuration tem; 545 Server ~| &sofDste |Mon 02/26/2007 | e fooem =
»
Matching the following criteria:
Reports | Reported 057 | [eontains =] i =
Search e =1 Reported 05 =] [cortains =] fwina =)
Search | Result Opfions... | Save Search.. | Cancel |
22 [zerver ame x|
| server Hame Serialumber | Primary P | operating System [ manutacturer Mol | Hostrame B
B 167 dew opaware... BREWES 132168197147 Red Hat Enterprise .. DELL COMPUTER C... FOWEREDGE 750 m167 dev.opsware... |
B vizzard dev.opsw.. BYRTAS! 13216813333 Red Hat Enterprise ... DELL COMPUTER C... POWEREDGE 1750  blizzard dev.opsw
BB 133 2RAP3T 192168136227 Red Hat Enterprise ... DELL COMPUTER C... POWEREDGE 630 m133
BB r13e 4RAVP3T 132168135244 Red Hat Enterprise ... DELL COMPUTER C... POWEREDGE 650 m134
| r163 dew opsware... 5504051 192168135245  Red Hat Enterprise ... DELL COMPUTER C... POWEREDGE 1750 m163 dev opsware
| ranagedvit VMWARE-S6 4D 83, 192166203224 Red Hat Enterpriss .. YWWARE, INC VIMWARE YIRTUAL. . managedyh
EB| ri278nt-vmn2.devo.. YMAARE-S6 4D 8D, 19218820276 SuSE Linux Erterpri... WMAWARE, INC WAMWARE YIRTUAL. . m273-nt-vn2.dev.o
B} stesto 43HC201 192168874 SUSE Linux Erterpri.. DELL COMPUTER C... OPTRLEX GX110  sles10
B stest0-x86-64-ntt .. 79F0GEH 19216820113 SuSE Linux Erterpri... DELL ING POWEREDGE 1350 slea10-86-64-int-t
B} sunMicrosystems- .. xG054813010 192168163152 SuSE Linux Erterpri... SUN MICROSYSTE .. FIRE v20Z dhep-rik
B} trnone 0002B3CB25E5 1821666137 SUSE Linux Erterpri... HEWLETT PACKARD HP NETSERVER LPR  (none)
BB dhep-5.c28.dev.op... HEFMABH 192168196245 YMwars ESX Serv... DELLING POWEREDGE 1350 dhop-5.623 dev.op
E}| esx3-04 dev.opsw... BTC2RA! 19216820320 Mwars ESX Serv... DELL COMPUTER C.. POWEREDGE 1850  esx3-04 dev.opsw
B} winnttestt s7LLI 1921688211 Windows NT 40 DELL COMPUTER C.. OPTIPLEX GX1 450... winnttest!
EB| mi260-w2kawm2  YMABRE-S64D00.. 1921881466181 Windows Server 2. WMWARE, INC YAMWARE YIRTUAL. . m260-w2k3- w2
B} testwarates VMAARE-S6 4023, 192166166185 Windows Server 2... YMWARE, INC VIMAARE VIRTUAL. . testw2k3155
BB vivtaketoonn opsw 170227137152 Windows Server 2... DELL COMPUTER C.. POWEREDGE 650 viviaket0000 opsw
B vivtaketoont opsw 171227137152 Windows Server 2. DELL COMPUTER C.. POWEREDGE 650 viviaket0Om opsw
BB vivtaketoonz opsw 172227137152 Windows Server 2... DELL COMPUTER C.. POWEREDGE 650 viviaket0002 opsw
BB woraspatest VMWARE-S6 4085, 192166166185 Windows Server 2... YMWARE, INC VIMWARE VIRTUAL. . w2k3sp2test
BB pkennedy-360.corp... GMS00S1 1921658169 Windaws XP DELL COMPUTER ... PRECISION WWORKS. . pkenriecy-350.corp
EB| wopnospvmatas  YMABRE-S64DC.. 132188466186 Windows XP VMWARE, INC VMABRE VIRTUAL .. wipnospmadss  «
Opsware Administration [

distart| > @ & ¥ D2 wze| Or| Ee | B || S| W2 Bge | (O] @2 T2 | é‘@rf' « 1P| T 4:20Pm

You can assign a name to the selection criteria used for this search, and save it as a
report. At a later date, you could select the report from the OMDB Client and run it
again.

However, you can also save this search as a BIRT report. Doing so will allow you to
open the report in BIRT to improve its appearance and functionality.

El Click Save Search.

E Save the search with a descriptive name, so that you can run it in the future from the
OMDB Client. In the Search Name field shown in Figure 2-4, enter a Search Name,
such as SAS Server_ Search.
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EEl Select Save as a Report Definition.

Figure 2-4: Save or Delete Your Search

Search for Configuration fetm: FAS Server ~| ssoiDate: |Mon 022662007 v Titne: IZ:DD Phi = I

Matching the following criteris:

I Reported OSLI kontains LI ILinux t]
lnr ;I | Reported OS;I kontains LI Iwind E]
Search | Result Options... | Save Search... | Canzel |
|| —

| Server MNarme Serial Mumber | Pritnary [P | Operatil EEErIEE hatme | =3
m miE7 dev opsware... BREVWEST 192.165.197 147 Red Hat ISAS Server Search .dev.opsware...;l
@:l blizzard dev.opsw... BYRTGS1 19216819599 Red Hat - - ard cev opsw...
= Saved Searches
ER| m133 2FWVP31 192168196227  Red Hat
D AFPF 192165196244  Red Hat
@:l m169.dev opsweare... 5504051 192165.196.245 Red Hat dev opsware...
ER| managech WMWARE-S6 4D 53... 192.168.203.224  Red Hat gediM
BR| m279-rt-vm2.dev.a... VMWARE-SE 4D 9D... 192.168.202 76 SuSE Li rtwmn2 devo..
ER| stest0 4SHC20 192.168.5.74 SUSE Lil i}
BR| sles10-x86-64-intt... 7OFOGET 192 168.201 13 SUSE Lil 0-xB6-Fd-irt-t .
ER| sun Microsystems-... XG054813010 192168163152 SuSELN _trik
BE| tnane) 00:02E3CE:28ES 1921685137 SuSE Li 3
@:l dhop-5.c29.dev.op... HEFMAET 192.165.196.246 Whbweare ¥ Save az a Repart Definition -5.c29.dev.op...
@:l esx3-04 dev.opsw... BTC2R 192.168.203.20 hlvvare 04 dew opswy..
ER| winnttestt B7LLA 1921688211 Windaw Save Delete Cancel fttestt
BR| m260-w2kavm2  VMWARE-SE 4D 00... 192.168.166.181 Window, 2k 3wz

EE Click Save, and then choose a directory to save the SAS Server
Search.rptdesign file to.

Scheduling a Report

You can schedule a report to run at a specified time, and to repeat at intervals. The report
can be emailed to one or more recipients when it runs.

To schedule a report, perform the following steps:

E From the report, click Schedule to open the Scheduled Report Options window
shown in Figure 2-5.

H n the Schedule Name field, enter the name. The default value is the report type
name.

Select the frequency, either Once, Daily, Weekly, or Monthly.

1 (Optional) Select the options available for Daily, Weekly, and Monthly, as appropriate.

Set the Start Time.
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Set the Start Date.
(Optional) Select End recurring schedule by, and then set the end date.

B In the Recipients field, enter one or more email addresses. If you are entering,
multiple addresses, the addresses can be separated by a space, comma, semicolon,
or a Return.

El Select a format for the report output.
X Click OK.

Figure 2-5: Scheduled Report Options

& Scheduled Report Options

Description

Schedule Natne: | Historical Compliance Detai |

EBazed on Report: Historical Compliance Detail

Schedule

Enahble the following schedule:

{:} Once Run every day(=) at the specified start time.
(%) Daily
{} Weekly

() Manthly

Start Time:

=tart Date: |Wed 05/09/2007 |[ﬂ [ ] End recurring schedule by: v

Recipients

E-tnail:

€ | )|

Format: @ poF  (COus O HIML

Ok ] [ Cancel
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Setting Scheduled Report Options

For scheduled reports an Administrator can set the following options:
« Maximum number of scheduled reports each user can enable

* Number of scheduled reports concurrently processed by server

The ‘Maximum number of scheduled reports each user can enable” option allows an user
only to enable the number of reports as set by the administrator. This option does not
prevent the user from creating unlimited number of scheduled reports.

If the administrator lowers the number of scheduled reports that a user can have enabled,
then the next time the user updates or creates a scheduled report, they may have to also
disable a number of their reports until they no longer exceed the maximum number of
scheduled reports. This option also will not allow the user to save changes to a scheduled
report if they have already enabled the maximum number of scheduled reports.

The “Number of scheduled reports concurrently processed by server” option enables an
Administrator to monitor that the server that processes scheduled reports are running
smoothly. This setting is designed to keep the server from crashing due to an excessive
number of reports being scheduled at the same time.

In the event that there are more scheduled reports scheduled to run at a specific time
than specified in this value, then the server will process the scheduled reports in batches
of the size specified in this value. Therefore, sometimes reports may not run at the time as
specified by the user. Running some reports may be delayed due to server load.

To set the options for scheduled reports, perform the following steps:

E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Scheduled Report Options. The Scheduled Report Options options appears in the
Content pane.

H Enter the value for the Maximum number of scheduled reports each user can enable
option.

Bl Enter the value for the Number of scheduled reports concurrently processed by
server.

Bl Click Save to save the Scheduled Report options.
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This section discusses the following topics:
+ Overview of Dashboard
+ Viewing the OMDB Dashboard

+ Setting Dashboard Options

Overview of Dashboard

The OMDB Dashboard displays useful summary type OMDB reports allowing you to view
important reports on a daily basis. It contains one or more of the following summary
reports in a graphical format:

+ Historical Compliance Summary
» Devices by Type

« Servers by Architecture

» Network Devices by Type

+ Servers by Operating System

You can drill down to the summary report to view the complete report in detail. In the
Dashboard, you can perform the following actions on the summary reports:

* Print reports

» Export OMDB report results as .html, .pdf, or xIs files

+ Drill down the summary report to view the complete report in detalil
» Perform action on report results

By default, the Dashboard contains the following five summary reports as shown in
Figure 3-1:
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Compliance % Over the Last 30 Days: This report displays the compliance history of
servers and network devices over the last 30 days at daily intervals.

Devices by Type Over the Last 30 Days: This report displays the devices (servers and
network devices) deployed over the last 30 days at daily intervals.

Servers by Operating System Over the Last 30 Days: This report displays the
servers organized by operating system and version over the last 30 days at daily
intervals.

Network Devices by Type Over the Last 30 Days: This report displays the network
devices (such as routers, switches) deployed over the last 30 days at daily intervals.

Servers by Architecture Over the Last 30 days: This report displays the servers
organized by CPU architecture over the last 30 days at daily intervals.
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Figure 3-1: OMDB Dashboard
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In the OMDB Client, you can also create and configure your own personal Dashboard. You
can select up to eight reports to be displayed in your Dashboard from the list of reports
mentioned above. You can also configure your Dashboard to be in either a one-column or
two-column layout. See “Setting Dashboard Options” on page 62 for more information.

When you launch the OMDB Client, by default the Search feature is displayed in the
Content pane. You can also configure the dashboard options to display the Dashboard
feature in the Content pane when you first launch the OMDB Client. See “Setting
Dashboard Options” on page 62 for more information.

Viewing the OMDB Dashboard

To view the Dashboard in OMDB, perform the following steps:

H Inthe OMDB Client, from the Navigation pane, select Reports » Dashboard. The
default Dashboard appears in the Content pane.

B To create your personal Dashboard, see “Setting Dashboard Options” on page 62.

(Optional) To view the complete report in detail, click on any report in the Dashboard.
The complete report appears in the Content pane.

Bl (Optional) Click Export to export the reports displayed in the Dashboard. The Export
Results window appears. Enter the location, the file name and the file type and then
click Save. You can export OMDB report results as .html, .pdf, or xls files.

(Optional) Click Print to print the reports displayed in the Dashboard.

(Optional) To perform an action on the report results, select an item from the Content
pane and then right-click to select the appropriate action.

Setting Dashboard Options

In the OMDB Client, you can create and configure your own personal Dashboard. You can
select up to eight reports to be displayed in your Dashboard and specify the parameter
values for those reports. You can also configure your Dashboard to be in either a one-
column or two-column layout.

To configure the Dashboard options, perform the following steps:
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E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Dashboard Options. The Dashboard options appears in the Content pane.

Figure 3-2: Dashboard Options Window

% Dashboard Options

Startup Location Dashboard Selector Custorn Dashboard Column Selector
D Reports @ Use Default Dashboard Q} One Column
@ Search O Custorn Dashboard O Twwo Columns

O Dashboard

Custotn Dashboard Configuration Panel e

Report: 1

Report File |Hi3’[0ric:al Compliance Summary W |

Title | |

Report: 2

Repart File |Deviu:ea By Type bl |

Title | |

A
T
o
=1
=1
5]

Report File |Servers By Architecture w |

Title | |

=0
[11]
=
o
=1
=

Report File |Netwc-rk Devices By Device Type % |

Title | |

Report: 5

Save Layout

H From the Startup Location options, select an option to be displayed every time you
launch the OMDB Client. You can select either Reports, Search, or Dashboard. Select
the Dashboard option to display the Dashboard feature when you launch the OMDB
Client.

B From the Dashboard Selector options, select Custom Dashboard to configure your
Dashboard using the reports that are available.

Opsware Inc. Confidential Information: Not for Redlistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 63



Opsware® OMDB 1.0.2 User’s Guide

Bl From the Custom Dashboard Column Selector options, select One Column to display
the reports in a one-column format in the Dashboard. Select Two Columns to display
the reports in a two-column format in the Dashboard.

H To configure a report in the Dashboard, perform the following steps:

Different reports have different report parameters to configure. For example, for the report

"Network Devices by Device Type," you can configure the parameters such as Device
Group, Vendor, and Model. For the report “Servers by Operation System”, you can
configure the parameters such as Customer, Facility, and Device Group.

1. From the Custom Dashboard Configuration Panel in Report 1, select a report from
the Report File drop-down list.

2. (Optional) Enter the report title in the Title field, or the default report name will be
used for the report title.
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3. Click Configure. The Report Dialog window appears.

Figure 3-3: Report Dialog Window
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4. From the Date Range drop-down list, select a date range to run the report.

5. From the Interval drop-down list, select the time interval to run the report. The
Interval drop-down list allows you to group the data on a daily, weekly, or monthly
time interval.

6. From the Customer drop-down list, specify the customer to be included or
excluded in the report.

7. From the Facility drop-down list, specify the facility to be included or excluded in
the report.
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8. From the Device Group drop-down list, specify the device group to be included or
excluded in the report.

9. Click Run. The report with the specified parameters is displayed in the Content
pane.

10. Click OK to save your changes or click Cancel to close the window.
@ To configure more reports, repeat the steps listed in Step 5.

Click Save Layout to save the Dashboard options.
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This section discusses the following information:

* Introduction

« Designing a Report

+ Editing a Report Definition File

+ Inserting a Chart

+ Integrating a Custom Report into the OMDB Client
» Creating OMDB-Derived Reports

» Advanced Topics For OMDB Custom Reports

Introduction

The Opsware family of products is comprised of a cluster of Oracle databases, typically
running on a Sun Microsystems minicomputer. These databases are continuously
refreshed and updated by agents residing on the managed servers and workstations in
the network.

Opsware SAS enables you to create and design reports and integrate them into the SAS
Client and the OMDB Client.

This chapter presents how to use content selected from these databases and create
custom reports. It explains how to create a simple SQL query, how to design a report, and
how to integrate it into the Opsware OMDB user interface.

The recommended authoring environment for custom OMDB reports includes the
following items:

» A file transfer tool

« An SQL Query Tool
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» Business Intelligence and Reporting Tools (BIRT) RCP Designer
(http://www.eclipse.org/birt) BIRT release 2_1_1

« BIRT library file cmdb-data-sources.rptlibrary

- JDBC driver file ojbc14.jar

Designing a Report

Begin your report design by defining its content. To define the report’s content, you should
determine the report’s purpose, the type of information displayed, and the logical
grouping of the data set. Then, you can map the content definition into the product-
specific database schema by determining how Opsware should represent the data
needed, the names of the tables where the data is stored, and the names of all of the
fields within those tables.

Using this information you can write the SQL query that Opsware will use to generate the
report.

Writing the correct SQL query is the most difficult part of report creation. The standard
reports contain a set of queries that are good candidates to borrow work from. The report
(.rptdesign) files can be found in an installed OMDB core at /opt/opsware/omdb/
reports. Whether borrowing from existing reports or creating original content, consider
using a tool such as PL/SQL Developer to refine and optimize your SQL.

When you have optimized the SQL, you should test your SQL query to ensure that the
SQL is valid and returns the expected data.

No AAA-specific considerations need to be made in your SQL. The report engine will
automatically transform the SQL that you have created at runtime to constrain the report
results to what the current user can see.

Editing a Report Definition File
E nthe OMDB Reports chapter, perform the task “Saving a Search as a Report”.

H Start BIRT 2.1.1. In a Windows command prompt, run the command birt .exe.
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Open the SAS Server Search.rptdesign file that you just created.

As shown in Figure 4-4, the new report contains the form and content of the
information you selected when defining the report. The header information is already

in place.

Figure 4-4: New Report in BIRT
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icon.

In the Outline pane, expand Data Sources, and then double-click the Data Source

H View the information for the new JDBC Data Source as shown in Figure 4-5.

Opsware Inc. Confidential Information: Not for Redlistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.

69



Opsware® OMDB 1.0.2 User’s Guide

@ Click Test Connection to ensure that the report is connected.
Figure 4-5: JDBC Connection

bl New JDBC Data Source Profile x|

Create a new data source

<
Create a new data source

Driver Class:

Database URL: | jdbc:oracle:thin:@cmdb, opsware, com: 1521 :cmdb
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Manage Drivers... | Test Connection..,

< Back [ext = | Einish I Cancel
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Select the Preview tab, and review the report.

Figure 4-6: Preview Tab
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B Click on the XML Source tab to see the SQL query that the OMDB Client generated.

Figure 4-7: XML Source Tab
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<property name="cueryText">SELECT distinct BASE TABLE.ITEM ID AS ITEM 1D,
TABLE_1.COLUNN_O 45 COLUMN O, J
TABLE 2.COLUMN 6 AS COLUMN &,
TABLE_1.COLUMN_1 &S COLUMN 1,
TABLE 3.COLUMN 10 A3 COLUMN 10,
TABLE_z.COLUMN_7 4S COLUMN_7,
TABLE 2.COLUNN & AS COLUMN 8,
TABLE_1.COLUNN_2 45 COLUMN 2
FRON (SELECT BASE TABLE.ITEM ID &S ITEN ID,
BASE_TABLE. ITEN SOURCE_ID &S ITEN SOURCE_ID,
BASE_TABLE.CREATE DATE S CREATE DATE,
BASE_TABLE.NODIFY DATE kS MODIFY DATE,
BASE_TABLE.TND OF LIFE DATE A5 END OF LIFE DATE
FRON CNMDE_DATA.SAS_SERVERS_BASE BASE_TABLE) BASE_TABLE
LEFT OUTER JOIN (SELECT TABLE 1.ITEM ID &S ITEN ID,
TABLE_1.ITEN SOURCE_ID &S ITEN SOURCE_ID,
TABLE 1.BEGIN DATE A5 BEGIN DATE,

- =
Sfownez| =0 TABLE_1.END_DATE AS END_DATE,

TABLE_1.LATEST FLAG A5 LATEST FLAG, _'LI
3

4
Layout | Master Page | Script | <ML Saurce | Preview |

Property Editor - Data | = Properties EZI ~ =07

Prapert | value |
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El To group the output by operating system, select the top cell in the header row, right-
click and select Insert Group from the menu as shown in Figure 4-8.

Figure 4-8: Inserting a Group

N e B |

) I I I I

: Id Server Serial Primar Operati Man

E Name Numbe yIP n ctur
¥ g
- = System
< Undo Delete group ¥

: = [ITEM W Redo N [COLUMN | [COLUMN | [COLU
- 1] _1m 7

: B of Cutt

. B b MM SORY

? . Paste

- ¥ Delete

“_‘ Insert L4

5 LI IMerge Cells

) - Split Gell

Layout | Master Page | Script | sML So

Insert Group

Property Editor - Data =] Properties : e

Propert: Style ’

S "B — Edit Data Binding

ackgroun

In the next window shown in Figure 4-9, you can select the column that will provide

the group identity.
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K Select COLUMN_10 to specify the Reported OS column.

Figure 4-9: New Group Creation
=

‘ Group Details |

Mame: ~Sort Dirsction
| operatingsystem & Ascending
Group On: " Descending

[otomm o = | T —
Interval: Rangs: Before: [auto -

— =
[hi nterval =l[e = | after: o =

™| ise Fixed base value For intervals ¥ Fispest Hesdsr

I Hide Detail

IOC Item Expression:

~Filters and Sorting

Filters | Sorting |

Expression [ operator [ value 1 [ value 2 [

oK Caneel

EEH Click OK.
EH Select the Layout tab.
EE Select the Properties tab.
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KB Select the Font properties to make this field smaller and darker.

Figure 4-10: Font Properties

Il
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As shown in Figure 4-11, the report now groups the output by operating system.

Figure 4-11: Preview of Grouped Report

-lolx
File Edit Insert Page Element Data Run - Search ‘indow Help
Ici-z [@- |- |4 ]| |[1om
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F28CIF AS3 PL
4E-03 52 F1
67 2D SDr
C18F
. = 5989 fakee. 0000, opsware. com 220.15.157.24 Red Hat DELL COMPUTEER. PC
Bowmemz| =0 Enterprise Linux CORPORATION 651
FX-0] i
4| | L'J

Layaut | Master Page | Script | <ML Source | Preview

Property Editor - Data | = Properties EZI ~ =07

Prapert | value |
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Inserting a Chart

BIRT can generate a chart to visually display selected elements of the output. Figure 4-12
displays the detailed SQL query that the SAS OMDB Client created. This is the search-
Result-Dataset based on the cust-DataSource data source.

Figure 4-12: SQL Query

LB i o e earancst paset i
-Daka Source Query - -
- Query
A Available Items: 1SELECT distinct BASE_TAELE.ITEM ID AS ITE,~
peomputedisclonns SR s e s 2 TABLE_1.COLUMN 0 AS COLUMN 0,

::tr:r";emrs 583 CMDB_DATA 3 TABLE_2.COLUMN & AS COLUMN &,
Froperty Binding 4  TABLE 1.COLUMN 1 AS COLUMN 1,
s s 5  TABLE 3.COLUMNN 10 AS COLUMN 10,
I e———— 6  TABLE 2.COLUMN 7 AS COLUMN 7,
7 TABLE 2.COLUMN & AS COLUMN 8,
8  TABLE 1.COLUMN 2z AS COLUMN 2
-8 TsMsYS 9FROM (SELECT BASE_TABLE.ITEN ID AS ITEN I
10 BASE_TABLE.ITEN SOURCE_ID AS ITEN SOU.
11 BASE_TABLE.CREATE DATE AS CREATE DATE
12 BASE_TABLE.MODIFY DATE AS MODIFY DATE
13 BASE_TABLE.END OF LIFE DATE AS END OF
14FROM CHDE_DATA.SAS_SERVERS BASE BASE_TABL:
Schemas [-Al- ~| | 15LEFT OUTER JOIN (SELECT TABLE 1.ITEM ID &
16 TABLE_1.ITEM SOQURCE ID AS ITEN SOURCE
Fiter: | 17 TABLE_1.BEGIN DATE AS BEGIN DATE,
: 18 TABLE_1.END DATE AS END_DATE,
Type:  [-al- | M 19 TABLE_1.LATEST FLAG AS LATEST FLAG,
(] (e G s STACLE LIS MAE A5 COLUI O, o v

Ok I Cancel |

To create a new data set based on the same cust-DataSource data source, perform the
following steps.

E From the Data menu, select New Data Set.

Figure 4-13: New Data Set

i BIRT RCP Designer
File Edit Insert Page Element | Data ‘Window Help

It

Mew Data Source

e C|ass, rpdesic

Mormal | Master Pag
|

0

[El-[F Data Sources
B Data Source
3 Truth

SR [ak S Sets
({3 Report Parameters
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H To learn how many instances of each operating system are currently online, in the
Query pane type the SQL statements Select Count (*) From and Group By. Then,
drag the desired Available Items from the middle pane to their places in the query
text.

The final SQL statement is:

select CMDB_DATA.SAS SERVERS.REPORTED OS,
count (*) from CMDB_DATA.SAS SERVERS
group by CMDB_DATA.SAS SERVERS.REPORTED_ OS

Figure 4-14: Data Set Query
MBEdtDataset Datasubset _loix]

Diata Source Query e - i

CQutput Columns

—————— Available Teems: lselect CMDE DATA.SAS SERVERS.REPORTED 05, -]
OMmnpUCes olumns - - — —
Parameters E1-E5] 5AS5_SERVERS | Zeount (%)
U | I B ITEM_ID (NUMEER) 3from CHDE_DATA.SAS SERVERS
oropertyBndng M B ITEM_SOURCE_ID (MUY 4group by CHDE_DATA.SAS SERVERS.REPORTED O:
Cache Preference | El BEGIN_DATE (TIMESTA
PreviewResute | i El END_DATE (TIMESTAMP

----- El LATEST_FLAG {(MUMEER:
----- B HOST_NAME (¥ARCHAR
----- E REPORTED_OS (¥ARCH.
----- El DISPLAY_MAME (VARCH

""" B MoTES (WARCHARZ) =
d : -

Schema: I-AII- j

Filter: |
Tvpe: I-AII- 'l EDD'YF"terl

-
™ Use identifier quoting 4| | _’I—I

Ok I Cancel |

H Click OK.

Bl Drag the Chart icon from the Palette tab to the Layout panel.
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From Select Chart Type menu, select Pie Chart.

Figure 4-15: Chart Type

New Chart

New Chart

Select chart bype and choose an output Format,

Pie Chart Title

AKX

Bar Chart
@ Ling Chart
u Area Chart
7
@ Meter Chart
! Scatter Chart
[ij_[ Stock Chart

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 79



Opsware® OMDB 1.0.2 User’s Guide

@ Click Next. A screen similar to Figure 4-16 appears.

Figure 4-16: New Chart

New Chart

New Chart

Select the data to display in the chart and bind it to the series,

Select Chart Type [Select Datal Format Chart

rSlice: Size Definition:

ISeries 1 'l!l
[rowf"eounTey fy| oo
L

Chart Preview

25—

Pie Chart Title

215;\ {50

1

50

I RedHatE..
B Linux4AS

[] Sun0S54

[ AIX43

B Swn0SE10

L Category Definition: | row["REPORTED_05"]

Select Data Set
" Inherit Data from Container
% |se Data Set

Data Preview

A |

IData SubZet VI Create New. .. |

—
Optional Grouping:

A

Group Sorking:

IAscending - l

_

-

_l_l Data Binding. .. |

REPORTED_OS || EENTEE |
Red Hat Enterprise Linux A5 3 50

Linu 445 1

SunQs5 5.9 25

ATX 4.3 25

SunCS 5,10 50

AT TS, o

I Y

To bind a data column ko the chart, use the right-click menu or drag the column to

the appropriate text field,

Filters. .. |
Parameters. ., |

< Back

Mext = | Einish | Cancel |

From the Select Data Set option, select Use Data Set, and then select Data SubSet
from the drop-down list. The Data Preview pane displays the contents of the data set.

Drag the COUNT(*) header to the Slice Size Definition field.

Drag the REPORTED_OS header to the Category Definition field.
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KXY Click Next.

Figure 4-17: Report Operating Systems

New Chart |
New Chart -
Fine tune your chart by defining the series properties, interactivity, layout, as well as general formatting of text, shadows, :
background and borders,
Select Chart Type | Select Data [Format Chartl
- Series Chart Preview
- Cakegory Series
-Value Series 2
o Reported Operating Systems
-Plat 1
..... Legend 50
25 7/\\ [ Red Hat Enterpris...
L) B Linux4as
— [] Sun0S54
| “—10
25—’ [] Al43
B 5un0s5.10
50 B WWindows NTE.2
Chart Area
Chart Title: |Rep0rted Operating Systems _I v visible
Background: I j
Skyle: INone j [V Enable in Preview
Inkerackivity
v Enable
Legend Behavior: INone j
Title Interactivity | Chart Area Inkeractivity |
Title Format | Qutline | General Properties | Custom Properties |
Help < Back | [dext = | Einish | Cancel

EEl Select the Chart Area line to call up the input fields. You can use these to assign a
chart title and to define the background.

EH Click Finish.
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As Figure 4-18 shows, the Layout view displays an icon of the chart, rather than the
chart itself.

Figure 4-18: Layout View of Chart
-lolx|
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Drag the chart icon to the top of the report.
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KB Pull the handles on the icon to expand it.

Figure 4-19: Chart Icon
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K Click Preview.

Figure 4-20: Report Preview
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Integrating a Custom Report into the OMDB Client

To
(1]

integrate the report into the OMDB Client, perform the following steps:

Copy the custom report to the /opt /opsware/omdb/reports directory. Repeat
this step for additional cores as needed; report files aren't automatically replicated.

To see this report listed in the OMDB Client, add it to report_def . xml.

Modify the report_def.xml file in the /opt/opsware/omdb/deploy/birt.war
directory that the OMDB Client uses to recognize, display, and invoke the reports

stored on each core. If you are using WinSCP, you can double-click on the report _
def .xml file name to open the document for editing.

Insert a description of your report in the top part of the .xm1 file. The easiest way to
do that is to copy an existing report definition, paste it in, then modify the report
name, display name, and description to match your new custom report.

84 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 4: OMDB Custom Reports

In the following sample text, the new report is defined in the bold text.

<reportings
<reports>
<location>/etc/opt/opsware/occ/reports</location>
<report name="ServerByOSChart.rptdesign">
<display names>ServerByOSChart Title</display
name>
<description>ServerByOSChart Desc</description>
<parameters>
</parameters>
</report>
<report name="SAS Server Search.rptdesign">
<display name>SAS Server Search</display name>
<description>SAS Server Search</description>
<parameters>
</parameters>
</report>

In the report_def .xml file, modify the folder section to specify where the new
report will go. In the following example, we are telling the SAS Client to make the
sample report available in the Compliance Reports folder.

<folder name="compliance reports'"s>
<display name>complianceReportsFolderDesc</
display name>
<folder reportss
<report name>
ServerConfigurationPolicyComplianceChart.rptdesign</report
name>
<report_name>SAS Server_ Search.rptdesign</report name>

<report
name>ApplicationPolicyComplianceChart.rptdesign</report
name>
<report name>
ApplicationPolicyComplianceTableByCustomer.rptdesign</
report_name>
<report
name>ApplicationPolicyComplianceByFacility.rptdesign</
report_name>
</folder_ reportss
<subfolderss>
<subfolder name>sox</subfolder namex>
</subfolders>
<parents>reports</parent>
</folders>
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Make a backup copy of the report def .xml file before you edit it. A typographical
error in this file can prevent all reports, custom or otherwise, from being displayed.

When you use the OMDB Client, you can view and run your new report.

Creating OMDB-Derived Reports
To create an OMDB report, perform the following steps:
El Launch BIRT RCP Designer.

H In the Outline pane, right-click Libraries, and then select Use Library. The Open
window shown in Figure 4-21 displays.

Figure 4-21: Assigning a Library to the Report

een 2
Look jr: IE}cIark j \) _? 3 '

. cmdb-data-so ary
opsw-common-reporting. rptlibrary

File name: Icmdb-data-sources.rptlibrary j Open I
Filez of type: I"_rptlibrary j Cancel |
¥

Browse to the directory where omdb-data-sources.rptlibrary can be found,

select it, and click Open.

After you assign the library, you do not need to create a new data source. This library

automatically points the user to the JDBC source.

Bl View the data connection in the Edit Data Source window shown in Figure 4-22.
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H To test the data connection, click Test Connection.
Figure 4-22: Edit Data Source

pifi Edit Data Source - Data Source

=10l x|

- Property Binding

Database URL: | jdbec:oracle:thin:@cmdb, opsware . com: 1521 :cmdb

User Mame: | cmdb_reporter
Password: | FTITITITIITITIT)
JMDI URL: | java:fomdbReporterDS
Manage Drivers... | Test Connection..,

Ok I Cancel
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@ Create and name a new data set as shown in Figure 4-23 and Figure 4-24.
Figure 4-23: New Data Set

i BIRT RCP Designer

File Edit Insert Page Element | Data Run Search ‘Window Help

= I l
JrJv J@v J%v J Mew Data Source J -
Palette
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Mew Report Parameter # ple.rptdesign &1
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Figure 4-24: Name New Data Set

i New Data Set '

Ed
New Data Set

Create a new data set, !: 1

Data Set Mame: | CMDE _sample

Data Source:

Data Sek Type: ISQL Select Query

= Back I Mext = I Eimish

Cancel

Click Next.
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B Create the SQL query. Drag and drop the selected data rows into the SQL panel on
the right, remembering to add SQL commands, commas, and spaces, as needed.

Figure 4-25: Creating SQL Query
JRI=TE

ata Source Query - -
Query
Cutput Columns
Computed Calurns
Parameters
Filters
Property Binding
Cache Preference
Preview Results

lselect * ﬂ
2from CMDE_DATA.NAS_DEVICES

=-33 cMpe_DATA
DATE_DIMENSICN_BASE

HAS_BPPROVAL_STATUS

MAS_CFG_POLICY_DEYICES
hAS_CFG_POLICY_DVC_GR.
hAS_CONFIGURATION_POL
hAS_CONFIGURATION_RUL
NAS_CONFIG_POLICY_RULE

i NAS_DEVICES &
| D)

Schema: I-AII- h
Filter: I

Type: |—AII— 'I BDD\YF\Iterl

I Use identif -
Use identifier quating LI 5

El Click Preview Results to see if the SQL parses and runs.

Figure 4-26: Preview Results

b Edit Data Set - CMDB_sample D ol x|

-Data Source Preview Results - o -
- Query
- Dukput Columns ITEM IO |_ITEM_SoURCE 1o BEGIN_DATE | Ene paTe | LaTEST FLAG |~
Computed Columns G056 8056 Jan 8, 2007 00 AM  Feb 21, 2007 00 AM 0
- Parameters 087 5057 Row 25, 2008 2:00 AM | Feb 21, 2007 200 AM 0
Fiters 053 5058 Aug 29, 2006 200 AM Feb 21, 2007 200 AM D
059 5059 Ort 12, 2006 100 &M Jan 1, 4000 1Z:00 &M 1
EZ?:;‘;:;:;TEE 8086 8085 Feb 22, 2007 :00 AM | Feb 22, 2007 3:00PM 0
! 057 5057 Feh 22, 2007 200 M Feb 22, 2007 300PM 0
- Preview Results 8088 8088 Feb 22, 2007 9:00 AM | Feh 22, 2007 3:00PM 0
086 5056 Feh 22, 2007 300 PM | Feb 22, 2007 200PM 0
057 5057 Feh 22, 2007 300 PM  Feb 22, 2007 200PM 0
053 5058 Feh 22, 2007 3:00 PM  Feb 22, 2007 200PM 0
086 5056 Feh 23, 2007 200 M Jan 1, 4000 12:00 &M 1
057 5057 Feh 23, 2007 200 &M Jan 1, 4000 12:00 &M 1
053 5058 Feh 23, 2007 200 &M Jan 1, 4000 1Z:00 &M 1
086 5056 Feb 21, 2007 3:00 PM  Feb 21, 2007 200PM 0
057 5057 Feh 21, 2007 300 PM  Feb 21, 2007 200PM 0
053 5058 Feb 21, 2007 3:00 PM  Feb 21, 2007 200PM 0
086 5055 Feh 22, 2007 200 PM Feb 23, 2007 300 AM 0 p
057 5057 Feh 22, 2007 200 PM Feb 23, 2007 300 AM 0
053 5058 Feh 22, 2007 200 PM  Feb 23, 2007 300 AM 0
086 5056 Feb 21, 2007 200 PM  Feb 22, 2007 300 AM 0
057 5057 Feb 21, 2007 200 PM | Feb 22, 2007 300 AM 0
053 5058 Feh 21, 2007 200 PM  Feb 22, 2007 300 AM 0
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KK Drag the Table icon from the Palette to the middle row of the layout grid.
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EEl \When the Insert Table window appears, set the number of columns to three.

BB Drag the desired fields from the Outline tab on the left into position on the table.

Figure 4-27: BIRT RCP Designer
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EEl Select the Preview tab to preview your report.
Figure 4-28: Show Report Parameters
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KB Integrate the new report into the Opsware OMDB Client. The procedure is described
in “Integrating a Custom Report into the OMDB Client” on page 84.

Advanced Topics For OMDB Custom Reports

This section contains the following advanced topics for OMDB custom report creation:
» Parameter Substitution
« Dates

+ Actionability

Parameter Substitution

For OMDB, a com.opsware.reporting.util package was created to use with BIRT.
Reports are currently JDBC-based and include embedded SQL. In the data-set of the
BIRT Reports for the OMDB, set the beforeOpen script to:

importPackage (Packages.com.opsware.reporting.util)
request = reportContext.getHttpServletRequest () ;

var requestParamMap = new Packages.java.util.HashMap () ;
for (1 = 1 ; 1 < ${Number of Parameters + 1} ; i++)

{

requestParamMap.put ("PARAM" +

i, reportContext.getParameterValue ("PARAM" + 1i));
requestParamMap.put ("PARAM" + i +

"CO", reportContext.getParameterValue ("PARAM" + 1 + "CO"));
requestParamMap.put ("PARAM" + i +

"DT", reportContext.getParameterValue ("PARAM" + 1 + "DT"));

}

queryText = SqlUtilities.processBeforeOpenEvent (queryText,
requestParamMap, request) ;

This will retrieve the SQL query for the report and pass it to a parser to replace any
runtime variables. Runtime variables for the OMDB reporter are denoted in the SQL as
ansi style C comments and have a begin and end tag. The begin tag is /*PARAM'n"*/ and
the end tag is /*/PARAM'n' */ where 'n' is greater than 0. In addition to the begin and
end tags, there is a operator position tag /*Cx* /.
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In the above code the token $ {Number of Parameters} should be replaced with the
number of parameters that the report has + 1. For example, if the report has 4
parameters, replace the token $ {Number of Parameters} with the number s.

For example, the query below for a report with runtime value:

select full date

from cmdb_data.date dimension

where 1 =1

/*PARAM1*/and full date /*C*/ = trunc(sysdate)/*/PARAM1*/

When the report is run, one of the following events occur:

« |f the user selects Any Value for the parameter, then the string between the begin and
end tags is removed.

 If a value is picked with an operator (in, equal, not equal) then the string between the
operator position tag and end tag is replaced with the appropriate operator/parameter
value string.

+ If the parameter value is text and case-insensitive (by default), then the left-side
expression between AND or OR and the operator position tag will be enclosed by an
UPPER function. The parameter value will also be upper-case.

Parameters in report def .xml for OMDB take a string of SQL for their lookup values.
This is different from the way reports are parameterized in SAS, with a resource type and
resource field.

Report parameter substitution is not supported in local previews. To test this feature, you
must deploy it to the OMDB server.

Dates

The OMDB reporting data source omdb-reporter-ds.xml used by the OMDB BIRT
engine is configured to set all session connections to the current user's time zone as
these connections are accessed by BIRT. This allows for the use of certain functionality
within Oracle to ensure that date processing occurs and is displayed relative to the user's
time zone.
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The OMDB cMDB-DATA schema includes a DATE_DIMENSION view that is useful in
creating the date-based SQL typically used in OMDB's historical reporting. This view
contains a number of date-related columns for reporting including FULL_DATE _LOCAL
and FULL_DATE_UTC. All columns are relative to the user's local midnight boundary
(including FULL DATE_LOCAL) except for FULL DATE UTC. FULL DATE UTC is a
calculated value based on the offset of the user's time zone from FULL_DATE_LOCAL.
The time component of FULL_DATE_LOCAL is always midnight (00:00:00), so for
someone in New York (EST), FULL_DATE_UTC will be 5 hours later than FULL_DATE
LOCAL meaning its time component will be 05:00:00.

When doing parameter substitution of single dates or date ranges, these values will be
substituted in the current user's time zone and should always be compared to
FULL_DATE_LOCAL. When using the resulting DATE_DIMENSION records to access
historical data tables, the FULL_DATE_UTC column must be used as all OMDB data time
stamps are UTC.

The following two functions are available for performing time zone offsets:

+ UTC_TO_LOCAL: Use this to convert almost all OMDB time stamp columns to local
time for display in the user's local time zone

+ LOCAL_TO_UTC: This will convert a local time stamp to UTC, which may not be useful
for return to BIRT, but may be useful in other scenarios.

Almost all time stamp columns returned for display in BIRT should be wrapped in the
UTC_TO_LOCAL function for correct display. The only time you wouldn't do this is if there
is a need to display the date in UTC or if a BIRT expression is being used to convert the
UTC time stamp to some other desired value.

Actionability

OMDB reports can also support actionable items. For example, a server entry in a report
can be set as actionable. Right-clicking on that server displays a pop-up menu of actions
available for that server.

To set a table as actionable, perform the following steps:

El Launch BIRT RCP Designer.

H n the Outline pane, expand the report name, and then expand Body.
H Select the table name.

Bl In the Property Editor -table name, click the Properties tab.
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B In the Properties list, select Bookmark.
[ In the text field, enter the following string:
id="''actionable'’

From the File menu, select Save.

The format for OMDB actionable items is

source:object type:id

To add the source and object type to your custom report, perform the following steps:

E Launch BIRT RCP Designer.

Expand Data Set.

Double-click the data set that is associated with the report.

In the query text field, add the following string:

'source:object type:' || objectid

The actionable source and object_type pairs are limited to:

sas:device:
sas:patch policy:
sas:configuration:
sas:compliance test:
sas:configuration:
sas:compliance test:
sas:job:

sas:user:
sas:usergroup:
sas:audit policy:
sas:audit task:
sas:audit_ result:

Set the objectid to the object id in SAS or NAS. Do not set objectid to anitem

id in OMDB.

Click OK.

< o o

Expand the Data Set.

In the left list of the Edit Data Set window, click Output Columns.

Drag the new column into the table as the first column of the Detail Row of the table.
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